Excel
Excel Options – click the Microsoft Office Button. Go to Excel Options
Templates – click the Microsoft Office Button. Go to New – Installed Templates
Exercise 1: Enter text
1. Open a blank spreadsheet. The Home tab at the top of the Ribbon should be highlighted.
If it isn't, click it.
2. In cell A1, type Product Name, and then press ENTER. The text is too long for the cell; it
spills over into cell B1.
3. Click in cell A1.
4. On the Home tab, in the Alignment group, click the Wrap Text button

.

A single click wraps the text.

Exercise 2: Change document view
1. At the lower right of the screen, locate the View toolbar

.

2. Click the middle button on the toolbar, Page Layout View, to change to Page Layout
view. Or click the View tab on the Ribbon, and then click Page Layout View in the
Workbook Views group.
Now the column and row headings are above the worksheet grid.
3. Now you'll zoom in and out of the worksheet. To do this, click the minus sign (-) or the plus
sign (+) to the right of the toolbar.

If you click the minus sign several times, you can see several worksheets at once in Page
Layout view. The indicator to the left of the minus sign shows you the percentage of the
magnification. Click the plus sign until you get back to 100%.

Exercise 3: Adjust column width in Page Layout view
1. In cell B1, type text that will be too long to fit into the cell: Quantity per Unit. Press
ENTER, and then click in cell B1 again.
2. Instead of wrapping the text so that it will fit, you'll make the column wider to fit the text.
3. On the Home tab, in the Cells group, click the arrow below Format, and then under Cell
Size, click AutoFit Column Width.
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The column width automatically changes to fit the text in the cell.
You can still use the double-click method to change the column width as well. Point at the
right edge of the column heading until you see a cross with a double-headed arrow in it,
and then double-click.

Exercise 4: Show or hide white space in Page Layout view
1. Move the pointer into the space between the top of the page and the column headings (A,
B, C, and so on).

2. When the pointer turns into two arrows, click once.
The white space is hidden.

To show the white space again, point at the same space until you see two arrows pointing
away from each other. Click once.
3. Change back to Normal view. On the View toolbar, click the Normal button
the left.

on

4. Go the Page Layout tab. Go to Sheet Options. Uncheck View under Gridlines and
Headings.

Exercise 5: Add the Excel 97-2003 Workbook command to the Quick Access Toolbar
Until everyone you work with is using Office 2007, you can add the Excel 97-2003 command to make it
quick and easy to convert your files.
1. Click on the arrow to the right of the Quick Access Toobar.
2. Go to More Commands.
3. In the drop down box that now says Popular Commands, choose the Office Menu.
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4. Choose the Excel 97-2003 Workbook command and add it to the right side and click OK.
5. Click your new button to see how easy it is to convert the file.
Close the file and don’t save.

Exercise 6: Insert a column
1. Open the Excel Practice file. In the worksheet, click in cell D4 (or any cell under
Supplier).
2. Now, on the Ribbon, in the Home tab, go to the Cells group, click the arrow to the right (or
below depending on your resolution) of Insert, and then click Insert Sheet Columns.
A column is inserted to the left of the Supplier column.
3. At the top of the new column, in cell D1, type the column title, Category. Now fill in a little
data. In cell D2, type Dairy Products. In cell D3, type Grains/Cereals. With
Grains/Cereals still highlighted, click Format and click AutoFit Column Width in the Cells
group.
4. Use the double-click method to fit the Product Name and Supplier columns to the correct
width.
5. Change the Orientation to Landscape. Go to Page Layout – Orientation.

Exercise 7: Use Sum
In this exercise you'll enter a formula by using the Sum

button.

1. Place the cursor in cell C51, so that you can add up the number of products listed in the
Quantity column.
2. On the Home tab, in the Editing group, click the Sum

button. Then press ENTER.

Excel adds up the total, using the SUM function, and enters the total, 1177.

Exercise 8: Enter a formula using Formula AutoComplete
1. Click in cell C52. Type an equal sign (=) to start the formula, and then type S for the SUM
function.
2. A list appears with the functions that you might want to insert. You will have to scroll a bit
in the list to see SUM.
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3. Double-click SUM to enter it in the worksheet. (If you press ENTER while SUM is
highlighted in the list, instead of double-clicking it, you may see an error in the worksheet.)
To complete this formula, type C2:C50) and then press ENTER.
Now you have the same formula entered twice; once with the Sum button in cell C51, and
once by using Formula AutoComplete in cell C52.

Exercise 9: Add a header and footer
In this exercise you'll create a header and footer for the worksheet in Page Layout view.
1. Click Page Layout View on the View toolbar

in the bottom right of the window.

2. Scroll up to the top of page 1, or press CTRL+HOME. Click where it says Click to add
header. Notice that as soon as you click there, a new tab appears on the far right side of
the Ribbon, the Design tab, under Header & Footer Tools.
Note If you are in Page Layout view, but you cannot see the area that says Click to add
header, it means that white space is hidden. Click once in the space between pages to
show the white space.
Type June Sales Report.
3. Scroll to the bottom of the first page. Click where it says Click to add footer. Notice the
Design Toolbar is now available. In the Header & Footer group, click the arrow on
Footer, and then click Page 1. "Page 1" is inserted.
Note that an auto footer can be inserted only in the center of the worksheet. The same
goes for an auto header.
4. Click in the footer area and add one blank space to the right side of the footer area. In the
Ribbon, in the Header & Footer elements group, click Sheet Name. You'll see &[Tab]
inserted in that part of the footer area. Click outside of the footer (do not click Enter) and
you'll see the name of the worksheet, "Contoso Sales Data," in the footer area.
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Exercise 10: Add a few finishing touches
You can stay in Page Layout view for now.
1. Scroll up to the top of page 1, or press CTRL+HOME. Place the cursor in the first row. On
the Home tab, in the Cells group, click the arrow next to Insert, and then click Insert
Sheet Rows. Click Insert Sheet Rows again to insert a second row.
2. In cell A1, type Contoso Sales Data.
3. Select cells A1 through E1. On the Home tab, in the Styles group, click the arrow next to
Cell Styles, and then select any style you like for the sheet title. Mouse over the different
choices to see a preview before selecting.
4. Merge the cells across the top, and then center the title. Select cells A1 through E1, and in
the Alignment group, click the Merge and Center button
.
5. Select the column titles in row 3. In the Font group, click the Bold
the titles in bold type.

button to show all

6. Click on Print Preview on the Quick Access Toolbar or to go Microsoft Button – Print –
Print Preview.
7. Click on Page Setup – Center on Page Horizontally. Close Print Preview.

Exercise 11: Print options
1. Your worksheet should still be in Page Layout view, with some space in between the
pages.
2. At the top of the Ribbon, click the Page Layout tab.
3. If you want to print column and row headings, in the Sheet Options group, under
Headings, select the Print check box. Note that the option to print gridlines is just next
door; under Gridlines, there's a check box for Print.
4. Check your Print Preview once again. Close Print Preview without printing.
5. Close and do not save changes.

Exercise 12: Format date as a serial number
1. Open the Work with Dates file. Click on cell A2, which contains the value 8/22/2010.
2. On the Home tab of, find the Number group.
3. Click the arrow in the Number Format box.
4. Change the selection from Date to General.
5. Select cell A2 which now contains the value 40412.
6. Click the Number Format drop down box again.
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7. Click on Short Date, which displays the date in number format (as opposed to Long Date,
which spells out the month).

Exercise 13: Select different date formats
1. Select cell D2, which contains information in date format.
2. Click the arrow in the Number Format box.
3. Scroll to the bottom and select More Number Formats. This will open the Format Cells
dialog box.
4. Make sure you are on the Number tab. Click Date in the Category list, and then click a
format in the Type list.
5. Click OK to apply the new format and close the dialog box.

Exercise 14: A Couple of Keyboard Shortcuts
1. Select any empty cell.
2. Press CTRL+; (semicolon) and press Enter. You have the current date
3. Press CTRL+: (colon) and press Enter. You have the current time.
4. Type in 12.45 in any empty cell. Press CTRL+$ to format it to currency. Press CTRL+& to
add a border.

Exercise 15: Find the total number of days between two dates
Enter a formula to find the number of days between 6/9/2011 and 8/21/2011.
1. Type 6/9/2011 in cell A6 and 8/21/2011 in cell A7.
2.

Select cell B9

3. Type =A7-A6. Ignore Formula AutoComplete.
4. Press ENTER to display the result.
5. There are 73 days between the two dates.

Exercise 16: Find the number of workdays between two dates
This exercise uses the NETWORKDAYS function, so you can find the number of workdays (Monday
through Friday) between 6/9/2011 and 8/21/2011.
1. In cell B11, type = and then ne. Formula Autocomplete will finish the formula for you as
you type. Double-click the function to enter it automatically.
2. Finish the formula by completing the arguments: A6,A7)
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3. Press ENTER. The answer is 52 days.

Exercise 17: Find the date after a number of workdays
This exercise uses the WORKDAY function. Suppose that it's 12/31/2010, and you have 80 days to
complete a project. Type a formula to calculate the project end date, accounting for holidays between the
two dates.
1. In cell G9, type =WO and then mouse down and double click on Workdays.
2. Type G3,G4,G5:G7) The commas separate the arguments. The colon indicates the cell
range from G5 through G7. The final parenthesis closes the formula.
3. Press ENTER. The answer is 4/22/2011, accounting for holidays between the two dates.

Exercise 18: Create a chart
1. Open the Chart Work file. Click in cell A2, and then drag to cell D5 to select the data in
those four rows and columns.
2. Click the Insert tab. In the Charts group, click Column and choose the Clustered Column
in the 2-D Column section (the screen tip will show the name).
A chart is inserted on the worksheet. It compares salespeople to each other, month by
month. The names of the salespeople are in the chart legend, and the months are at the
bottom of the chart.

Exercise 19: Look at chart data another way
1. Click on the Chart. Chart Tools should appear on the Ribbon.
2. On the Design tab, in the Data group, click Switch Row/Column.
Now the chart legend shows the months of the year, and the salesperson names are at
the bottom of the chart.
3. Now put the chart back to the way it was. Click Switch Row/Column.

Exercise 20: Update chart data
1. Click in cell D3.
2. Change the data from 300 to 500, and then press ENTER.
The column for Guissani in March is updated, growing taller. Also, the values on the
vertical axis on the left changed, to adjust for the larger value added to the data.
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Exercise 21: Add titles.
1. If necessary, click in the chart to display the Chart Tools. Click the Design tab to display
the commands.
2. On the Design tab, in the Chart Layouts group, click the More button
see all the layouts in the group.

so that you can

3. As you rest the pointer over each layout, a ScreenTip is displayed with the name of each
layout. When you get to Layout 9, click it.

Placeholders are inserted for Chart Title and for the vertical and horizontal Axis Titles.
4. At the top of the chart, click "Chart Title" and type Northwind Traders Tea and press
Enter.
5. Now type the axis titles. At the bottom of the chart, select the horizontal placeholder "Axis
Title." Type First Quarter Sales and press Enter.
6. At the left side of the chart, select the vertical ―Axis Title‖. Type Cases Sold.

Exercise 22: Change chart layouts
1. Click inside the chart. If necessary, click the Design tab.
2. In the Chart Layouts group, click the More button

to see all the layouts.

3. Choose Layout 2, and then click it.
This layout moves the legend to the top and removes the chart axes. It also removes the
gridlines, which are the horizontal lines that extend from the value axis on the left across
the chart to help you see the value of each of the columns.
The layout also adds data labels above each column that show the number of cases of tea
sold by each person for each month. With data labels, you don't need gridlines.
4. Go back to Chart Layouts, click the More button

again, and locate and click Layout 5.

This layout puts the legend at the bottom and adds a data table, which contains all the
data used to create the chart. It also removes the axis title at the bottom of the chart.
5. Go back to Layout 9.
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Exercise 23: Change the chart type
1. Click in the chart.
2. Click the Design tab if it is not already selected. In the Type group, click Change Chart
Type.
3. Under Column, click 100% Stacked Column. Look at some of the other choices.

Exercise 24: Change the look of the chart
1. Click anywhere inside the chart.
2. Click the Design tab. In the Chart Styles group, click the More button
see all the styles. Choose any style that you like by clicking it.

so that you can

The new colors and style are applied to the chart.

Exercise 25: Try out a color scheme by using a theme
1. Click the Page Layout tab.
2. In the Themes group, click the arrow on Colors.
3. Rest the pointer over any of the colors in the list. The colors are shown in a temporary
preview on the chart. If you see one you like, click it. Or you can leave the chart as is.
Note : Theme colors change the style of other elements in your worksheet, too. For
example, if you had previously applied a cell style, that style would now take on the style
of the theme color you select for the chart.

Exercise 26: Format the chart title
1. Click in the chart title.
2. Click the Format tab. In the WordArt Styles group, click the arrow on Text Fill
,
and then rest the pointer over any of the colors. You'll see the title change. Choose a color
in the theme group.
3. In the WordArt Styles group, click the arrow on Text Fill again, and note the Gradient
option and the Texture option.
4. Try also Text Outline
and Text Effects
, and see the options there. If you find
that you add more options than you like, you can always get back to the beginning by
right-clicking in the title area and selecting Reset to Match Style or pressing CTRL+Z.
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Exercise 27: Format a column
1. Click on the first column on the left, the first column for Giussani. You should see round
selection handles at the corners of each of the three columns for Giussani.
2. On the Format tab, in the Shape Styles group, click the arrow on Shape Effects, point to
Shadow, and rest the pointer on the different shadow effects. A ScreenTip describes each
effect. Click one that you like.
If you don't like the results, you can get back to the original by right-clicking and selecting
Reset to Match Style.

Exercise 28: Format other areas of the chart
1. Click in the Plot Area (the area with gridlines). To be sure, on the Format tab, look in the
Current Selection group to see if Plot Area is displayed at the top of the group.

Looking in the Current Selection group is how you can ensure that you have selected the
correct area in a chart.
2. On the Format tab, in the Shape Styles group, click the arrow next to Shape Fill
. Rest the pointer on any of the Theme Colors. You can see the Plot Area
change color as you pass the pointer over the different colors. If you see a color that you
think improves the look of the chart, click it.
3. Next in the Shape Styles group, click Shape Effects
, and then point to
Shadow. Under Outer, click the first shadow in the list (the ScreenTip says Offset
Diagonal Bottom Right).
4. Close and do not save.

Exercise 29: Make a pie chart
1. Open the Chart Work 2 file. Click the Pie Chart tab at the bottom of the worksheet.
2. Select cell A2 and drag to cell B6 to select the data in those five rows and two columns
(do not select the total in cell B7).
3. On the Insert tab, in the Charts group, click Pie, and then click the first chart under 3-D
Pie (the ScreenTip says Pie in 3-D).
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4. On the Design tab, in the Chart Styles group, click the More button
styles, and pick another style for the chart.
5. On the Design tab, in the Chart Layouts group, click the More button
layouts. Click Layout 2.

to see all the

to see all the

The chart is done. The percentages are shown for each part of the pie.

Exercise 30: Save a chart as a template
Perhaps you need to create the same type of chart every week, every month, or every quarter in a report.
You don't have to go back to scratch and customize it all over again. Just save the chart as a template.
Then when you have new data, just open the template, and you're done.
Note

Colors applied through Themes will not be saved with the template.
1. Click the Practice tab at the bottom of the window. Click inside the chart. On the Design
tab, in the Type group, click Save As Template.
2. In the File name box, type a name for the template; for example, type My Practice
Template. Then click Save.
3. Click the Insert tab. In the Charts group, click Column (it could be any chart type you
click). At the bottom of the list, click All Chart Types.
4. In the Change Chart Type dialog box, at the top of the list on the left, click Templates. In
the box on the right, under My Templates, is the template you just created. If you point at
it, you will see the name you gave it.
5. To delete the template you just created, click Manage Templates at the bottom of the
Change Chart Type dialog box that is still open from the previous step. In the Charts
dialog box, on the right, you should see a chart template icon and Microsoft Office Chart
Template. Right-click the template and select Delete. You will be asked if you are sure if
you want to send the template to the Recycle Bin. Click Yes.

Exercise 31: Add your chart to a PowerPoint presentation
1. Right-click inside the chart and then click Copy on the shortcut menu.
2. Click Start, and open PowerPoint 2007. Open the Chart Work PowerPoint file.
3. Click the slide thumbnail for slide 2 on the left to select it. Near where it says "Click to add
text," right-click and then click Paste to paste the chart into PowerPoint.
Notice the Paste Options
button in the lower-right portion of the window. If you click
the button you'll see that the chart will automatically be updated if the data is revised in
Excel: The Chart (linked to Excel data) option is selected.
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4. Now click the Microsoft Excel
icon in the bottom of the window. In
cell B3, change the data for Giussani from 280 to 70, and press ENTER. You see the first
column in the chart change.
5. Click the PowerPoint
icon in the bottom of the window. The
first column in the chart for Giussani has changed there as well.
6. In PowerPoint, click inside the chart. Notice that the Chart Tools and the Design, Layout,
and Format tabs are available. You have the same chart commands available in
PowerPoint as in Excel, so you can make additional formatting or other changes in
PowerPoint if you need to. The formatting changes you make in PowerPoint are not made
to the chart in Excel.
You can also copy and paste your chart into a Microsoft Office Word 2007 document, and
the same Chart Tools are available there as well.

Exercise 32: PivotTable Reports
A PivotTable report turns all that data into small, concise reports that tell you exactly what you need to
know. When you create a PivotTable report, each column of your source data becomes a field that you
can use in the report. Fields summarize multiple rows of information from the source data.
1. Open the PivotTable Practice file. Place the cursor anywhere in the data (all data will be
included in the report).
2. On the Insert tab, in the Tables group, click PivotTable, and then click PivotTable again. The
Create PivotTable dialog box opens.
3. Select a table or range is already selected for you. The Table/Range box shows the range of
the selected data. New Worksheet is also selected for you as the place where the report will
be placed (you can click Existing Worksheet if you don't want the report placed in a new
worksheet). Click OK.
4. The left side is the layout area ready for the PivotTable report, and on the right side is the
PivotTable Field List. This list shows the column titles from the source data. Each title is a
field: Country, Salesperson, and so on.
5. How much has each salesperson sold? Select the check box in the PivotTable Field List next
to the Salesperson field. You also need data about how much they have sold, so select the
check box next to the Order Amount field. Notice that you don't have to use all the fields on
the field list to build a report.
6. The data in the Salesperson field (the salespeople's names), which does not contain
numbers, is automatically displayed as rows on the left side of the report. The data in the
Order Amount field, which does contain numbers, correctly shows up in an area to the right.
7. The heading over the salesperson data says "Row Labels" above the field. The heading over
the order amounts says "Sum of Order Amount"; the "Sum of" part of the heading is because
Excel uses the Sum function to add up fields with numbers.
8. What are the sales amounts for each salesperson by country? Right-click the Country field in
the PivotTable Field List and then click Add to Report Filter. The new Country report filter
is added to the top of the report. The arrow by the Country field shows (All), and you see the
data for both countries. To see just the data for either Canada or the USA, click the arrow and
select either country. To see the data for both countries again, click the arrow and then click
(All).
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9. What are the sales by date for each salesperson? Select the check box next to the Order
Date field to add the field to the report. Because the Order Date field is the second nonnumerical field to be added to the report, it is nested within the Salesperson field, indented to
the right.
10. To group the dates, click a date in the report. Then on the Options tab, in the Group group,
click Group Field. In the Grouping dialog box, select Quarters (deselect Months) and then
click OK. Now you see the sales data grouped into four quarters for each salesperson.
11. If you have a huge worksheet, it takes a little work to read the entire report; you have to scroll
down the page to see all the data.
12. You can pivot the report to get a different view. When you pivot a report, you transpose the
vertical or horizontal view of a field, moving rows to the column area or moving columns to the
row area.
13. To pivot this report, right-click one of the "Qtr" rows, point to Move, and then click Move
"Order Date" to Columns. This will move the entire Order Date field from the Row Label
area to the Column Label area of the report.
14. If you want to pivot the report back to the original view, right-click one of the "Qtr" headings,
and then select Move "Order Date" to Rows. That will move the Order Date field back to the
row area of the report.

Consolidate Data from Several Worksheets
To summarize and report results from separate worksheets, you can consolidate data from
each separate worksheet into a master worksheet. The worksheets can be in the same
workbook as the master worksheet or in other workbooks. When you consolidate data, you are
assembling data so that you can more easily update and aggregate it on a regular or ad hoc
basis.
For example, if you have a worksheet of expense figures for each of your regional offices, you
might use a consolidation to roll up these figures into a corporate expense worksheet. This
master worksheet might contain sales totals and averages, current inventory levels, and highest
selling products for the entire enterprise.
To consolidate data, use the Consolidate command in the Data Tools group on the Data tab.
If you want to…

Then…

Arrange the data in all worksheets in identical order and location

Consolidate by position

Organize the data differently in the separate worksheets, but use
the same row and column labels so that the master worksheet
can match the data

Consolidate by category

Use formulas with cell references or 3-D references to other
worksheets that you are combining because you do not have a
consistent position or category to rely on

Consolidate by formula

Use a PivotTable report instead of a consolidation

Use a PivotTable report to consolidate data
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Choosing Between Excel and Access

Access is best for

Excel is best for

Data entry.

Storing numbers.

Reports that users can run at any time.

PivotTable® reports — reports in interactive tables that allow you
to rotate the rows and columns to see different summaries of your
data.

Connecting to external databases and
editing data in those databases.

Charts, conditional formatting, color bars, and other visual data
displays.

Allowing multiple users to work on the
data simultaneously.

Greater familiarity. More people use Excel than Access.

Do you need to organize your data into a relational data structure or a flat data structure? Keep in mind
that Access is designed to work with relational data, while Excel works best with flat data structures.
In contrast to a relational data structure, a flat data structure is a simple list that isn't related to other data.
For example, a grocery list is a flat file, and so is a list of your friends and relatives. Flat data structures
are easy to create, and they're also easy to maintain, as long as you don't have too much information.
So how can you tell if you need a relational structure? By answering a few more questions:
First, do you have a lot of repeated data? For example, do you constantly enter the names of cities
or states? If so, you can put that repeated data into another table and create a relational structure.
Doing so can save you time and effort because you don't have to reenter the same information each
time you create a new record.
Second, do you want to track actions or events? For example, do you want to track sales or
customer complaints? Any time you want to track an action, a relational data structure usually works
best.
Third, do you need to store and manage your data, or do you need to analyze that data? If storage
is your primary goal, then use Access, but for analysis, use Excel.
Fourth, do you have a lot of data? For example, is your Excel worksheet so large that it's hard to
use? If so, even if you have flat data, Access can make your information easier to find.
Is your data mostly text, or is it numeric? Access can store a large amount of text — up to two
gigabytes in a single database — while Excel is designed to store numbers and perform
sophisticated calculations on them.

Office Live Workspace
Free online storage of documents
Can have up to 5 GB of data
Free web hosting
Google – Office Live Workspace and open an account
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